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What's New 1

1 What's New

New features in ODBC Driver for Twilio 1.1

¢ Fixed connection timeout setting before opening connection

e Now tokens and passwords are stored in an encrypted form in the DSN record

New features in ODBC Driver for Twilio 1.0

¢ |nitial release of ODBC Driver for Twilio
e Windows 32-bit is supported
e Windows 64-bit is supported

© 2015-2024
Devart. All Rights Request Support ODBC Forum Provide Feedback
Reserved.

2 General Information

1. Overview

2. Features

3. Compatibility
4. Requirements

5. Licensing
6. Getting Support
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2.1 Overview

Overview

Devart ODBC Driver for Twilio is a high-performance connectivity security with enterprise-
level features for accessing Twilio from ODBC-compliant reporting, analytics, Bl, and ETL
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ODBC Driver for Twilio

tools on both 32-bit and 64-bit Windows. Our ODBC driver fully supports standard ODBC API
functions and data types and enables easy and secure access to live Twilio data from

anywhere.

/ ODBC API |_—||:‘_‘\

o

+/ ODBC Data Types ‘L
[ |

Connection to Twilio

Our data connector enables various ODBC-aware applications to connect to Twilio directly
via HTTPS. If you have no direct access to Twilio via HTTPS, you have the option of
establishing a connection through a proxy server.

Application
ODBC Interface HTTPS
Driver Manager Proxy
Twilio
Devart ODBC Driver cloud
for Twilio
© 2015-2024
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2.2

Features

Application

HTTPS
0DBC Interface @
Driver Manager Proxy
Twilio
Devart ODBC Driver

for Twilio

Extended SQL Syntax

Our ODBC driver provides an unrivalled

opportunity to work with Twilio objects just

as with SQL tables. The extended SQL

syntax allows you to use all the SQL

benefits in SQL-92 compatible SELECT

statements:

* Complex JOINs

¢ WHERE conditions

® Subqueries

®* GROUP statements

* Aggregation functions
* ORDER statements

® and more.

Connection to Twilio

Our connectivity solution enables various
ODBC-aware applications to connect to
Twilio directly via HTTPS. If you have no
direct access to Twilio, you have the option
of establishing a connection through a

proxy server.

select
c.FirstName,
c.MailingCountry,
c.MailingStreet,
c.MobilePhone,
a.Accountiumber
from
{select
FirstName,
MailingCountry,
MailingStreet,
MobilePhone,
AccountId
from
Contact
where
MailingCountry = "USA') ¢
left join Account a
on c.AccountId = a.Id
where
a.Rating in ("Warm', "Hot')

© 2024 Enter your company name
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DML Operations Bulk Updates

Devart ODBC Driver for Twilio provides Moreover, with our driver you can perform
support for DML (INSERT, UPDATE, bulk updates to Twilio by combining SQL
DELETE) operations, which allows youto |statements into batches, thus simplifying
modify data in Twilio in the same way as in |and speeding up large data modification
SQL databases. with Twilio.

ODBC Conformance

The driver provides full support for common
ODBC interface:

e ODBC APIFunctions support g € \

= o
U

* ODBC Data Types support

In addition, we provide support for
Advanced Connection String parameters.
Thus allowing any desktop and web
applications to connect to Twilio from
various environments and platforms, that
support ODBC.
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Twilio Compatibility

+/ Twilio API
Our ODBC driver fully supports all data

+/ Twilio Data Types
types defined in the Twilio API.
Moreover, the driver is compatible with the
Twilio APl itself.

Integration
Advanced Data Conversion

The driver is compatible with 3rd-party data

We have implemented advanced Data analysis tools, such as Microsoft Excel, and
Conversion mechanisms that provide bi- |integrates with various IDEs and systems
directional mapping between any Twilio like Visual Studio, etc.

and ODBC data types. For a complete list of compatible tools and

platforms, see Compatibility.

Platforms Variety Fully Unicode Driver

. - With our fully Unicode driver, you can
Devart ODBC Driver for Twilio can be used

, . ) o retrieve and work with any data from muilti-
with 32-bit and 64-bit applications on both

. lingual Twilio databases correctly, not
x32 and x64 platforms, so there is no need
. , depending on whether its charset is Latin,
to additionally configure the driver,
o ] Cyrillic, Hebrew, Chinese, etc., in any
applications or environment.
environment localization.

High Performance Support

© 2024 Enter your company name
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2.3

Every operation with Twilio becomes o )

Visit our Support page to get instant help
significantly faster using such capabilities .

from knowledgeable and experienced
of our driver as Local data caching, _ _ _

professionals, a quick resolution of your
connection pooling, query optimization and . . .

problems, and nightly builds with hotfixes.
much more.

© 2015-2024
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Compatibility

Twilio Compatibility

Twilio API v

Twilio Data Types v

Supported Platforms

e Windows 32-bit and 64-bit (including Windows Terminal Server)
e Compatible with all Windows versions (Windows Vista and higher) that support .NET

Framework 4.5.

Compatibility with Third-Party Tools

Application Development Tools

Adobe ColdFusion
Embarcadero Delphi & C++Builder

FileMaker

CIS 1SS

Lazarus

© 2024 Enter your company name
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Microsoft Visual FoxPro

Microsoft Visual Studio
Server Explorer and ADO.NET ODBC Provider

Omnis Studio

PHP

PowerBASIC

CICC S

Python

Database Management

Aqua Data Studio

DBArtisan

dbForge Studio

dBeaver

EMS SQL Management Studio

Informatica Cloud

RazorSQL

SQL Server Data Tools

SQL Server Management Studio

CICOIC SO K

SQL Server Reporting Services

Bl & Analytics Software

Alteryx

<

DBxtra

<

Dundas Bl v
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FICO Xpress Mosel

IBM SPSS Statistics

MicroStrategy

Oracle Bl

Power Bl

Qlik Sense

QlikView

RStudio

SAP Crystal Reports

SAS JMP

Tableau

TARGIT

TIBCO Spotffire

CICIC SIS

Office Software Suites

LibreOffice

Microsoft Access

Microsoft Excel

OpenOffice

StarOffice

CIL LS

© 2015-2024
Devart. All Rights
Reserved.

Request Support

ODBC Forum

Provide Feedback
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2.4 Requirements

The following requirements must be met for ODBC Driver for Twilio:

¢ Only one version of ODBC Driver for Twilio is installed on your system.

e NET Framework 4.5 or later is installed on your system.

© 2015-2024
Devart. All Rights Request Support ODBC Forum Provide Feedback
Reserved.

2.5 Licensing

ODBC Driver License Agreement

PLEASE READ THIS LICENSE AGREEMENT CAREFULLY. BY INSTALLING OR USING
THIS SOFTWARE, YOU INDICATE ACCEPTANCE OF AND AGREE TO BECOME BOUND
BY THE TERMS AND CONDITIONS OF THIS LICENSE. IF YOU DO NOT AGREE TO THE
TERMS OF THIS LICENSE, DO NOT INSTALL OR USE THIS SOFTWARE AND
PROMPTLY RETURN IT TO DEVART.

INTRODUCTION

This Devart end-user license agreement ("Agreement") is a legal agreement between you
(either an individual person or a single legal entity) and Devart, for the use of the ODBC Driver
software application, demos, intermediate files, printed materials, and online or electronic
documentation contained in this installation file. For the purpose of this Agreement, the
software program(s) and supporting documentation will be referred to as the "Software".

LICENSE
1. GRANT OF LICENSE

The enclosed Software is licensed, not sold. You have the following rights and privileges,
subject to all limitations, restrictions, and policies specified in this Agreement.

1.1. If you are a legally licensed user, depending on the Software Edition specified in the
registration letter you have received from Devart upon purchase of the Software:

- the "Desktop Edition" allows you to install and use the Software on a single desktop

© 2024 Enter your company name
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computer, provided it is accessed by no more than one person at a time, either directly or
remotely, for sole purposes only in accordance with this Agreement. If more than one person
can simultaneously use the computer where you plan to install the product, you must
purchase a Server License. A Desktop License is valid for one single desktop installation;

- the "Server Edition" allows you to install and use the Software on a single server, provided it
is accessed by more than one person at a time, either directly or remotely. This definition
includes, but is not limited to, Web servers, application servers, batch servers, and desktop
workstations, where more than one concurrent users can access the Software. A Server
License is valid for one single server installation, provided it is used by 1 (one) legal entity in
accordance with this Agreement.

1.2. If you are a legally licensed user, depending on the License Type specified in the
registration letter you have received from Devart upon purchase of the Software:

- the "Subscription-based License" allows you to install and use the Software on a single
computer only during the subscription term specified at purchase. An Internet connection is
required to activate the license and check the license status when the Software is used.
Once the subscription term is over, you will be able to either stop using the Software or renew
the license for a new subscription term;

- the "Perpetual License" allows you to install and use the specific Software product version
on a single computer without an active subscription. A subscription provides access to new
product releases, regular upgrades, and support for new server versions provided during the
subscription term;

- the "Site License" allows you to install and use the Software on one or more computers in a
single company in accordance with this Agreement;

- the "OEM License" allows you to install and use the Software on one or more computers in
a single company as well as deploy the Software as part of a licensee's application to web
servers, application servers, batch servers, desktops, and other end-user devices. This
definition includes the ability to install and use the application containing the Software without
any additional fees in favor of the licensor.

1.3. If you are a legally licensed user of the Software, you are also entitled to:

- make one copy of the Software for archival purposes only, or copy the Software onto the
hard disk of your computer and retain the original for archival purposes;

© 2024 Enter your company name



General Information 1

- develop and test Applications with the Software, subject to the Limitations below.
1.4. If you have the "OEM License", you are also entitled to:
- make any number of copies of the Software to deploy it to your end-user.

- deploy the Software to your end-user as a Software installation package or integrate it into
your Applications.

1.5. You are allowed to use evaluation versions of the Software as specified in the Evaluation
section.

No other rights or privileges are granted in this Agreement.
2. LIMITATIONS

Only legally registered users are licensed to use the Software, subject to all of the conditions
of this Agreement. Usage of the Software is subject to the following restrictions.

2.1. You may not reverse engineer, decompile, or disassemble the Software.

2.2. You may not reproduce or distribute any Software documentation without express written
permission from Devart.

2.3. You may not distribute and sell any portion of the Software integrating it into your
Applications.

2.4. You may not transfer, assign, or modify the Software in whole or in part. In particular, the
Software license is non-transferable, and you may not transfer the Software installation
package.

2.5. You may not remove or alter any Devart's copyright, trademark, or other proprietary rights
notice contained in any portion of Devart files.

3. REDISTRIBUTION

The license grants you a non-exclusive right to reproduce any new software programs
(Applications) created using the Software. You cannot distribute the Software integrated into
your Applications unless you are an "OEM License" holder. Any Devart's files remain Devart's
exclusive property.

4. TRANSFER

You may not transfer the Software to any individual or entity without express written

© 2024 Enter your company name



12

ODBC Driver for Twilio

permission from Devart. In particular, you may not share copies of the Software under
"Desktop License" with other co-developers without obtaining proper license of these copies
for each individual; you may not install the Software under "Server License" on more than 1
(one) server without obtaining proper license of these installations for each server.

5. TERMINATION

Devart may immediately terminate this Agreement without notice or judicial resolution in the
event of any failure to comply with any provision of this Agreement. Upon such termination
you must destroy the Software, all accompanying written materials, and all copies.

6. EVALUATION

Devart may provide evaluation ("Trial") versions of the Software. You may transfer or
distribute Trial versions of the Software as an original installation package only. If the Software
you have obtained is marked as a "Trial" version, you may install and use the Software for a
period of up to 30 calendar days from the date of installation (the "Trial Period"), subject to the
additional restriction that it is used solely for evaluation of the Software and not in conjunction
with the development or deployment of any application in production. You may not use
Applications developed using Trial versions of the Software for any commercial purposes.
Upon expiration of the Trial Period, the Software must be uninstalled, all its copies and all
accompanying written materials must be destroyed.

7. WARRANTY

The Software and documentation are provided "AS IS" without warranty of any kind. Devart
makes no warranties, expressed or implied, including, but not limited to, the implied
warranties of merchantability and fitness for a particular purpose or use.

8. SUBSCRIPTION AND SUPPORT

The Software is sold on a subscription basis. The Software subscription entitles you to
download improvements and enhancement from Devart's web site as they become available,
during the active subscription period. The initial subscription period is one year from the date
of purchase of the license. The subscription is automatically activated upon purchase, and
may be subsequently renewed by Devart, subject to receipt applicable fees. Licensed users
of the Software with an active subscription may request technical assistance with using the
Software over email from the Software development. Devart shall use its reasonable
endeavors to answer queries raised, but does not guarantee that your queries or problems

© 2024 Enter your company name
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will be fixed or solved.

Devart reserves the right to cease offering and providing support for legacy Database
versions.

9. COPYRIGHT

The Software is confidential and proprietary copyrighted work of Devart and is protected by
international copyright laws and treaty provisions. You may not remove the copyright notice
from any copy of the Software or any copy of the written materials, accompanying the
Software.

This Agreement contains the total agreement between the two parties and supersedes any
other agreements, written, oral, expressed, or implied.
© 2015-2024
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26 Getting Support

This document lists several ways you can find help with using ODBC Driver for Twilio
describes the Priority Support program.

Support Options

There are a number of resources for finding help on installing and using ODBC Driver for
Twilio:
¢ You can find out more about ODBC Driver for Twilio installation or licensing by consulting

Installation and License articles of this manual respectively.

¢ You can get community assistance and technical support on the Community Forum.

® You can get advanced technical assistance by ODBC Driver for Twilio developers through

the ODBC Driver for Twilio Priority Support program.

Subscriptions

The ODBC Driver for Twilio Subscription program is an annual maintenance and support

service for ODBC Driver for Twilio users.
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Users with a valid ODBC Driver for Twilio Subscription get the following benefits:

e Product support through the ODBC Driver for Twilio Priority Support program
e Access to new versions of ODBC Driver for Twilio when they are released
e Access to all ODBC Driver for Twilio updates and bug fixes

¢ Notifications about new product versions

Priority Support

ODBC Driver for Twilio Priority Support is an advanced product support service for getting
expedited individual assistance with ODBC Driver for Twilio-related questions from the ODBC
Driver for Twilio developers themselves. Priority Support is carried out over email and has a
two business day response policy. Priority Support is available for users with an active ODBC
Driver for Twilio Subscription.

To get help through the ODBC Driver for Twilio Priority Support program, please send an
email to odbc@devart.com describing the problem you are having. Make sure to include the

following information in your message:

Your ODBC Driver for Twilio Registration number.

e Full ODBC Driver for Twilio edition name and version number. You can find the version
number in DLL version information.

¢ Versions of the Twilio server and client you are using.

e A detailed problem description.

e [f possible, ODBC Administrator Log, scripts for creating and filling in database objects, and

the application using ODBC Driver for Twilio.

If you have any questions regarding licensing or subscriptions, please see the FAQ or
contact sales@devart.com

© 2015-2024
Devart. All Rights Request Support ODBC Forum Provide Feedback
Reserved.
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1. Installation

. Connecting to Twilio

. Connection String Parameters

. Sandboxed Apps on macOS
. Using with iODBC
. Enabling ODBC Tracing

. Supported Data Types
. Supported ODBC API Functions

0 N O o~ W DN
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3.1 Installation

ODBC Driver for Twilio currently supports Windows 32-bit and 64-bit.

e Regular Installation

¢ Silent Installation

© 2015-2024
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3.1.1  Windows

Installation on Windows

1. Download and run installer executive file.

2. Follow the instructions in the wizard.
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i Setup - Devart ODBC Driver for Twilio - X

Welcome to the Devart ODBC Driver for
Twilio Setup Wizard

This will install Devart ODBC Driver for Twilio 1.0.0 on your
computer.

Itis recommended that you dose all other applications before
continuing.

Click Mext to continue, ar Cancel to exit Setup.

WARMIMG: This program is protected by copyright law and
international treaties.

ODBC Driver
for Twilio

3. In case you already have the specified installation folder on the PC or another Driver
version is installed, you will get a warning. Click Yes to overwrite the old files with the
current installation, but it is recommended to completely uninstall the previous driver
version first, and then install the new one.

4. On the Select Components page you can select whether to install the 64-bit version of the
driver or not. Clear the check box if you need no 64-bit installation. There is also a check

box on this page, that allows you to select whether to install Help and Manual.

© 2024 Enter your company name
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8 Setup - Devart ODBC Driver for Twilic — X

Select Components
Which components should be installed?

Select the components you want to install; dear the components you do not want to
install. Click Mext when you are ready to continue,

Full installation v
B Cevart ODEC Driver for Twilio 45,9 MB
ﬂ Driver for Win32 15,1 MB
ﬂ Driver for Wing4 29,9 MB
B Help and Manual 2,4MB

Current selection reguires at least 50,6 MB of disk space.
< Back Cancel

5. In the License Information dialog box, you should select the license type and activate the
product. If you have no activation key, you can select Trial and use the driver for evaluation
purposes.

6. If you have an activation key, select the Activation Key option. Copy the activation key from
the registration email or your Customer Portal account and paste it into the Activation Key

edit box.

© 2024 Enter your company name
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i% setup - Devart ODBC Driver — >
License Information
Fleaze enter the path to the file containing the activation key received when devart

purchasing the product. If you have no activation key, select Trial Version.

() Trial
(®) Activation Key

u 1w FjNOD SMGAPOSgfMzjuY AEoDpy fgL¥mIX heuy Hadt S8M4F ZgxWheiBjxwr LS

7 15QYwWOUQOeY Tatef2NfkwL gB +HFAVeYghal 3nMhifdvYIriwFFwZNVIRh 2m4s ]
72EIxR 30F{9BLspR & ydbomx YUY mTAZ FHMQVXWPGQN 2UM 1Y 4odf3c3TTj IRAUAG 2d
eminjcTIIN4HEPxigTQRRGZBHKT 1L 3IAR 1/ f¥sIp/PiKknDSIbxVK +avkETuP

5Qw 1IKL 7hTw0dwStsheAtwPzLEaTi30CHY 3 +2MLSII3 =|

Load Activation Key ...

7. If you have the activation key file, click the Load Activation Key button and browse to it.

Activation — O X

= v « Do, * Activation v O Search Activat.. 2

= This PC Mame Date modified Type

. 30 Ohbj E activation 27.03.2020 13:52 KEY File
I Desktoj
|j Docurm
4 Downlo

D Music v < >

1 itemn

8. Click Next.
9. Click Install, then Finish.

10.After the installation is completed, you need to configure the driver.

© 2024 Enter your company name
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3.1.2 Silent

Silent Installation with OEM license on Windows

1. Run the Command Prompt as an administrator.

2. Use the following command-lines to perform the driver silent/very silent installation:

DevartODBCTwilio.exe /SILENT /ActivationKey=ylc7nmgdu2341aszxcvONGurjfhxm90L
DevartODBCTwilio.exe /VERYSILENT /ActivationKey=ekhdh765mh09ukr237gfHRtrilwg
Note: The installation is performed by entering a license key.

DevartODBCTwilio.exe /SILENT /ActivationFile=d:\1lic.key

DevartODBCTwilio.exe /VERYSILENT /ActivationFile=d:\1ic.key

Note: The installation is performed by specifying the path to a license key file with any name.

When /SILENT is used, the installation progress is displayed, but no user interaction is
required during installation.

When /VERYSILENT is used, the installation wizard dialog is hidden and the installation
process is performed without user interference.

© 2015-2024
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3.2 Product Activation

¢ Obtaining Activation Key

e Activation on Windows

¢ Where to see the license information

© 2015-2024
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3.21 Obtaining Activation Key

To obtain a product activation key, follow these instructions:
1. After purchasing the license, you receive a registration email to the email address,

specified when ordering the product.

2. This email contains a Driver Activation Key and Login Credentials for the Customer Portal.

Keep this information secret.

3. You can copy the Activation Key either from the registration email or at the Customer Portal
account.

4. To login to the Customer Portal, use your Username and Password from the registration
email.

5. To obtain your Activation Key, click the View link on the right. You will get the following

dialog box:

Activation Key

ulw7jCODENGAEDFgbNZjuTATODWgLMNmD{ Meuy-+kt2YiSV39cp39ihBaIZ6mCh
fsILhFJgrehQWxTEmuz LIi+I0ycFEPkmX+Z5Y QP XiTebxgMUSHsUdPVskis
ImgHBa WSSO XuKKBzPIxDI81to5#5vmpp|LEEXvIaOkPRhdaraau3 UK

.....

COPY TO CLIPEQARD CLOSE

6. Copy the Activation Key with the Copy to Clipboard button.

See also:

e Activation on Windows

© 2015-2024
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3.2.2 Activation on Windows

Driver Activation After Installation
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To activate your installed driver using ODBC Administrator, perform the following steps:
1. Run ODBC Administrator.

Data Sources

(ODBC)

2. In the System DSN tab click the Add button.

; ODBC Data Source Administrator (4-bit)

User DSM  System DSN  File DSN  Drivers  Tracing Connection Pooling  About

System Data Sources:

Mame Platform  Driver 2 Add...
QODBC Driver for Azure_x32 32bit Devart ODBC Driverfor SGL S

QDB Driver for BigCommerce_x32  32-bit Devart OQDBC Driver for BigCor Remave
QDBC Driver for Dynamics_32 32bit Devart QDBC Driver far Dynam

ODBC Driver for Firebird_x32 32-bit Devart ODBC Driver for Firebir: Configure...

QDBC Driver for Magento_x32 32bit Devart QDBC Driver for Mager
QDBC Driver for MailChimp_x32 J2-bit Devart QDBC Driver for MailCh
QDBC Driver for MangoDB Gd-bit Devart QDBC Driver far Mongao
QDBC Driver for MangoDB_x32 32bit Devart QDBC Driver far Mongao

QODBC Driver for MySQL 32bit 32bit Devart ODBC Driver for MySGQ1 Y
£ >

An QODBC System data source stores information about how to connect to the indicated data provider.
A System data source is visible to all users of this computer, including NT services.

B

Cancel Apphy Help

3. In the appeared dialog box, select the installed driver, click Finish.
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Create Mew Data Source

Select a driver for which you want to set up a data source.

Mame T4

Devart QDBC Driver for BigCommerce

Devart QDBC Driver for Dynamics CRM

Devart ODBC Driver for Firebird .
Devart ODBC Driver for FreshBooks i
Devart QDBC Driver for Google BigGueny ’
Devart ODBC Driver for InterBase .
Devart QDBC Driver for Magento i

m Tl r B e

< >

< Back Cancel

4. In the Driver Configuration dialog box, on the License tab, click the Input Activation Key

button.
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| General Advanced Settings License  About

License Information:

Trial period:
30 days left |

Input Activation Key...

Test Connection . 0K Cancel

5. Copy the activation key from the registration email carefully and paste it into the Input

Activation Key edit box.

Input Activation Key >

Activation Key:

U 1w FRODEBGAEIFgbMZUTAToG v faLMmIX fheuy HdSpWCSKTE +d 2ZIwrmnI +A4A
u lw FCODENGAEDIFgbNzZiuTg ToD v /gLMmIX heuy Hel 5 IN4ZZgxWh 2MiXwr IS
A7E 103mgH6a 5w 1S fSQXuKKSzPIxDIS 1to 5 5vmppiL3EXvIaOkPRh4araausUf
a9BZh4ERVELA /pR IHWLZSXZ8k00 12Cx FaGy v 1¥hiknLRK 2L sbLMLP&mbxBC 2gn
WEZSMMErH72950xNiFvtZ IFnMsC 7 4scOuigWQsRed s =

Load Key... QK Cancel

6. If you have the activation key file, click the Load Key button and browse to it.
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7. Click OK.

© 2015-2024
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3.2.3 Where to See the License Information?

To see the license information of your installed driver, do the following:
1. In the Control Panel run ODBC Administrator

Data Sources
(QODBC)

2. Open the System DSN tab and click the Add button
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System Data Sources:

E ODBC Data Source Administrator (4-bit)

Mame

QODBC Driver for Azure_x32

QODBC Driver for BigCommerce_x32
QDBC Driver for Dynamics_32
QDBC Driver for Firebird_x32
QDBC Driver for Magento_x32
QODBC Driver for MailChimp_x32
QDBC Driver for MangoDB

QDBC Driver for MangoDB_x32

QDBC Driver for MySQL 32bit
£

Platfarm
32-bit
32-bit
32-bit
32-bit
32-bit
32-bit
G4-bit
32-bit
32-bit

Diriver

Devart QDBC Driverfor SAL 5
Devart QDBC Driver for BigCor
Devart QDBC Driver far Dynam
Devart QDBC Driver for Firebirc
Devart QDBC Driver for Mager
Devart QDBC Driver for MailCh
Devart QDBC Driver far Mongao
Devart QDBC Driver far Mongao

Devart ODBC Driver for MySQI ¥
>

B

Cancel

User DSM  System DSN  File DSN  Drivers  Tracing Connection Pooling  About

Add...

Remove

Configure...

Apply

An QODBC System data source stores information about how to connect to the indicated data provider.
A System data source is visible to all users of this computer, including NT services.

Help

3. Select the driver and click Finish
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Create Mew Data Source

Select a driver for which you want to set up a data source.

Mame T4

Devart QDBC Driver for BigCommerce

Devart QDBC Driver for Dynamics CRM

Devart ODBC Driver for Firebird .
Devart ODBC Driver for FreshBooks i
Devart QDBC Driver for Google BigGueny ’
Devart ODBC Driver for InterBase .
Devart QDBC Driver for Magento i

m Tl r B e

< >

< Back Cancel

4. In the appeared dialogue, select the License tab
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General Advanced Settings License  About

License Information:

Trial period:
30 days left |

Input Activation Key...

Test Connection . Ok Cancel

See also
e Product Activation

© 2015-2024
Devart. All Rights Request Support ODBC Forum Provide Feedback
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3.3 Connecting to Twilio

This section describes how to connect to Twilio using ODBC Driver for Twilio

1. Driver Configuration

2. How to Get Live Credentials

© 2015-2024
Devart. All Rights Request Support ODBC Forum Provide Feedback
Reserved.
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3.341

Connecting to Twilio

Windows DSN Configuration

To connect to Twilio you need to have the credentials. Please refer to the following
documentation on how get the Live Credentials. After installing the driver, create a DSN for
Twilio in the ODBC Data Source Administrator.

1. Open the ODBC Data Source Administrator.

e Type opBC Data Sources in the Windows search box and choose the application that
matches the bitness of the third-party application (32-bit or 64-bit). You can also open
ODBC Data Sources from Control Panel > Administrative Tools. Note that before
Windows 8, the icon was named Data Sources (ODBC).

e Alternatively, you can run c:\Windows\SysWoW64\odbcad32.exe to create a 32-bit DSN or c:
\Windows\System32\odbcad32.exe to create a 64-bit DSN.

2. Select the User DSN or System DSN tab. Most applications work with both types, yet
some applications require a specific type of DSN.

3. Click Add. The Create New Data Source dialog will appear.

4. Select Devart ODBC Driver for Twilio and click Finish. The driver setup dialog will open.

5. Enter the connection information in the appropriate fields.
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General Advanced Settings License  About

Data Source Mame Devart ODEC Driver for Twilio

Description

Account 5ID Your Account |

Auth Token YT I XIS IIII T [
B save Token

Proxy Server Port a

Proxy User ID

Proxy Password [save Password

Test Connection . Cancel

See Also
Connection Options

© 2015-2024
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3.3.2 How to Get Live Credentials

How to Get Live Credentials for ODBC Driver for Twilio

To successfully create the Twilio data source you need to use the Live Credentials: Account
SID and Auth Token. To get the credentials, perform the following:

1. Sign up or Sign in into your Twilio account.
2. Go to the Dashboard page of your Twilio account.

3. On the Account Info page, locate the Account SID and Auth Token sections and copy
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the credentials to create a data source connection.

Account ~

v Account Info

Account SID
Auth Token
essesesscssssssesssecsesscscssss

A Always store your token securely to protect your account.
Learn more [4

4. If you need to create another, Secondary token, go to Account, APl Keys and Tokens

page.
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Account v  Billing v

Manage account
General settings
Manage users
Subaccounts
Notification preferences

Audit events

Keys & Credentials

APl keys & tokens

Credentials

Connected apps

Trust Hub
Overview
Customer profiles
CNAM

A2P Messaging
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3.4

5. Request a secondary token and confirm the request:

Request a secondary token

Generate a secondary auth token to use as a backup or during key rotation.

6. After generating new credentials, or copying the already existing ones, use them to create
the ODBC connection.

© 2015-2024
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Connection String Parameters

Twilio ODBC Connection String Parameters

The following table lists the connection string parameters for ODBC Driver for Twilio.

Parameter Description
To connect to Twilio data source, you have to
Account SID provide the Twilio REST APl endpoint from

the Twilio URL textbox.

The Auth Token allows authorization of a

specific application to access Twilio data. To
Auth Token
save your Auth Token in the DSN settings,

select the Save Token checkbox.
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Advanced Settings

Allow NULL strings

Empty strings as NULL

Connection Timeout

ODBC Behavior

To retrieve metadata, not all parameters
according to MSDN can accept a null value. If
NULL, the driver should return an error. But
some 3rd-party tools pass NULL to the
parameters. These options should be
enabled for compatibility with such tools.

The time (in seconds) to wait for a connection
to open before terminating an attempt. The

default value is 60.

Used to set the behavior corresponding to
the ODBC specification version that a third-
party tool expects. The behavior of ODBC
driver can be changed by setting a value for
the SQL_ATTR_ODBC_VERSION attribute
by calling the SQLSetEnvAttr function. But
some third-party tools expect the driver to
exhibit ODBC 2.x behavior, but forget to call
SQLSetEnvAttr with the specified version or
pass an incorrect value there. In this case, the
required behavior can be explicitly specified
in the Connection String by setting the ODBC
Behavior parameter. The possible values

are:

® Default - default ODBC behavior
determined by a third-party tool.

* Ver 2.x- ODBC 2.x behavior is explicitly
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RegionalNumberSettings

RegionalDate TimeSettings

ReturnForeignKeys

String Types

set.
* VVer 3.x- ODBC 3.x behavior is explicitly

set.

Enables the use of local regional settings
when converting numbers to strings.

Enables the use of local regional settings
when converting dates and times to strings.
Use the option to specify whether the driver
must return foreign keys. Retrieving metadata
about foreign key constraints is a time-
consuming operation; many third-party tools
request foreign key metadata even whey they
do not actually need this information. Note
that enabling the option may degrade
performance of data access operations. The
default value is False.

Sets the string value types returned by the

driver as Default, Ansi or Unicode.

® Default - the driver defines the string types.

® Ansi - all string types will be returned as
SQL_CHAR, SQL_VARCHAR and
SQL_LONGVARCHAR.

* Unicode - all string types will be returned as
SQL_WCHAR, SQL_WVARCHAR and
SQL_WLONGVARCHAR.

The parameter value should be changed if

any third-party tool supports only Ansi string

types or Unicode ones.
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The time to wait for a query execution result

QueryTimeout
before terminating and generating an error.
Specifies whether all the datetime values
retrieved from the data source are returned
as UTC values or converted to local time and
UTC Dates whether the date values specified on the

application side (e.g., in SQL statements)
are considered UTC or local. The default

value is false.

ODBC Driver for Twilio Connection String sample

DRIVER={Devart ODBC Driver for Twilio};Account SID=Your SID;Auth
Tokeny=yourauthtoken

© 2015-2024
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3.5 Enabling ODBC Tracing

Creating an ODBC Trace Log on Windows

When you start or stop tracing in the 64-bit ODBC Administrator, the tracing is also enabled
or disabled in the 32-bit ODBC Administrator, and vice versa.

If the ODBC client application you need to trace runs under Local System account or any
other user login than your own, select Machine-wide tracing for all user identities. For
example, this option may be necessary for SSMS.

To generate a trace file using ODBC Source Administrator on Windows, follow the steps
below.

1. Type opBC Data Sources in the Windows 10 search box (in earlier versions of Windows,
open Control Panel > Administrative Tools) and choose the application of the needed

bitness.
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3.6

2. Select the Tracing tab.

w

. If necessary, change the default Log File path. Make sure that the path is writable by the
application, then click app1ly.

. Click start Tracing Now.

. Restart all application processes.

. Click Test connection in the DSN settings to make sure the driver is able to connect.

. Reproduce the issue.

. Click stop Tracing Now on the Tracing tab.

© o N O o b

. Send us the obtained log file (for example, devart.log).

Creating an ODBC Trace Log on macOS

To enable the trace option on macOS, use the Tracing tab within ODBC Administrator.
1. Open the ODBC Administrator.

2. Select the Tracing tab.

3. If necessary, change the default Log file path.

4. Select A1l the time in the when to trace option.

Creating an ODBC Trace Log on Linux

To trace the ODBC calls on Linux, set the Trace and TraceFile keyword/value pairs in the
[opBC] section of the /etc/odbcinst. ini file, for example:

[ODBC]
Trace=Yes
TraceFile=/home/test/devart. log

Make sure to disable logging after obtaining a log file since it affects the read/write speed.

© 2015-2024
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Supported ODBC API Functions

Supported ODBC Functions

The SQLGetInfo function returns information about the driver and data source. To find out
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whether a specific function is supported in the driver, call SQLGetFunctions.

For more information about the ODBC interface, see the ODBC Programmer's Reference.

ODBC Driver for Twilio supports all deprecated functions for backward compatibility.

The following table lists the currently supported ODBC functions.

Function Name Support Standard Purpose
Obtains an

environment,
SQLAllocHandle v, ISO 92 connection,
statement, or
descriptor handle.
Connects to a
specific driver by
SQLConnect ' ISO 92 data source name,
user ID, and
password.
Connects to a
specific driver by
connection string or
SQLDriverConnect ' ODBC requests that the
Driver Manager and
driver display
connection dialog
boxes for the user.
Obtains an
SQLAllocEnv v Deprecated environment handle
allocated from driver.
Obtains a

SQLAIllocConnect v Deprecated
connection handle
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ODBC API Calls for Obtaining Information about a Driver
and Data Source

Function Name Support Standard Purpose

Returns the list of

available data
SQLDataSources v ISO 92

sources, handled by

the Driver Manager

Returns the list of

installed drivers and
SQLDrivers ' ODBC their attributes,

handles by Driver

Manager

Returns information

about a specific
SQLGetInfo v ISO 92

driver and data

source.

Returns the functions
SQLGetFunctions v ISO 92 supported by the

driver.

Returns information
SQLGetTypelnfo v ISO 92 about supported
data types.

ODBC API Calls for Setting and Retrieving Driver
Attributes

Function Name Support Standard Purpose

Sets a connection
SQLSetConnectAttr v ISO 92

attribute.
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SQLGetConnectAttr
SQLSetConnectOpti

on

SQLGetConnectOpti

on

SQLSetEnvAttr

SQLGetEnvALttr

SQLSetStmtAttr

SQLGetStmtAttr

SQLSetStmtOption

SQLGetStmtOption

ISO 92

Deprecated

Deprecated

ISO 92

ISO 92

ISO 92

ISO 92

Deprecated

Deprecated

Returns the value of
a connection
attribute.

Sets a connection
option

Returns the value of
a connection option
Sets an environment
attribute.

Returns the value of
an environment
attribute.

Sets a statement
attribute.

Returns the value of
a statement attribute.
Sets a statement
option

Returns the value of

a statement option

ODBC API Calls for Preparing SQL Requests

Function Name

SQLAllocStmt

SQLPrepare

Standard

Deprecated

ISO 92

Purpose
Allocates a

statement handle
Prepares an SQL
statement for later

execution.
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SQLBindParameter

SQLGetCursorNam

e

SQLSetCursorNam

e

SQLSetScrollOption

S

Function Name Support

SQLExecute

SQLExecDirect

SQLNativeSql

SQLDescribeParam

SQLNumParams

ODBC

ISO 92

ISO 92

ODBC

ODBC API Calls for Submitting Requests

Standard

ISO 92

ISO 92

ODBC

ODBC

ISO 92

Assigns storage for
a parameterinan
SQL statement.
Returns the cursor
name associated
with a statement
handle.

Specifies a cursor
name.

Sets options that
control cursor

behavior.

Purpose
Executes a prepared

statement.

Executes a
statement

Returns the text of an
SQL statement as
translated by the
driver.

Returns the
description for a
specific parameter

in a statement.

Returns the number

of parameters ina
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statement.

Used in conjunction

with SQLPutData to

supply parameter
SQLParamData v ISO 92 PPYP

data at execution

time. (Useful for long

data values.)

Sends part or all of a

data value for a
SQLPutData ' ISO 92

parameter. (Useful

for long data values.)

ODBC API Calls for Retrieving Results and Information
about Results

Function Name Support Standard Purpose
Returns the number

of rows affected by

SQLRowCount v ISO 92
aninsert, update, or
delete request.
Returns the number
SQLNumResultCols .\/ ISO 92 of columns in the
result set.
] Describes a column
SQLDescribeCol v ISO 92
in the result set.
Describes attributes
SQLColAttribute .\/ ISO 92 of a columnin the
result set.
Describes attributes
SQLColAttributes v Deprecated

of a columnin the
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result set.

Returns multiple
SQLFetch v, ISO 92

result rows.

Returns scrollable
SQLFetchScroll v ISO 92

result rows.

Returns scrollable
SQLExtendedFetch v Deprecated
result rows.
Positions a cursor
within a fetched
block of data and
enables an
SQLSetPos v ODBC
application to refresh
data in the rowset or
to update or delete
data in the result set.
Performs bulk
insertions and bulk
. bookmark
SQLBulkOperations v ODBC
operations, including
update, delete, and

fetch by bookmark.

ODBC API Calls for Retrieving Error or Diagnostic
Information

Function Name Support Standard Purpose
Returns additional
SQLError v Deprecated error or status
information
SQLGetDiagField v ISO 92 Returns additional

© 2024 Enter your company name



Using ODBC Driver 43

diagnostic
information (a single
field of the
diagnostic data
structure).

Returns additional
diagnostic
information (multiple
fields of the

diagnostic data

SQLGetDiagRec v ISO 92

structure).

ODBC API Calls for Obtaining Information About
Database Objects (Catalog Functions)

Function Name Support Standard Purpose
Returns a list of

o columns and
SQLColumnPrivileg

es

-/ ODBC associated
privileges for one or
more tables.
Returns the list of

SQLColumns v X/Open column names in
specified tables.
Returns a list of
column names that

SQLForeignKeys v ODBC make up foreign
keys, if they exist for

a specified table.

SQLPrimaryKeys v ODBC Returns the list of
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SQLProcedureColu

mns

SQLProcedures

SQLSpecialColumn

S

SQLStatistics

ODBC

ODBC

X/Open

ISO 92

column names that
make up the primary
key for a table.
Returns the list of
input and output
parameters, as well
as the columns that
constitute the result
set for the specified
procedures.

Returns the list of
procedure names
stored in a specific
data source.
Returns information
about the optimal set
of columns that
uniquely identifies a
row in a specified
table, or the columns
that are
automatically
updated when any
value in the row is
updated by a

transaction.

Returns statistics
about a single table

and the list of
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indexes associated
with the table.
Returns a list of
tables and the
SQLTablePrivileges v, ODBC privileges
associated with
each table.
Returns the list of
SQLTables > X/Open table names stored
in a specific data

source.

ODBC API Calls for Performing Transactions

Function Name Support Standard Purpose

Commits or rolls
SQLTransact V' Deprecated .
back a transaction

Commits or rolls
SQLENndTran v ISO 92
back a transaction.

ODBC API Calls for Terminating a Statement

Function Name Support Standard Purpose
Ends statement

processing, discards
pending results, and,
SQLFreeStmt v ISO 92 optionally, frees all
resources
associated with the

statement handle.

SQLCloseCursor v ISO 92 Closes a cursor that
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SQLCancel

ISO 92

has been opened on
a statement handle.
Cancels an SQL

statement.

ODBC API Calls for Terminating a Connection

Function Name

SQLDisconnect

SQLFreeHandle

SQLFreeConnect

SQLFreeEnv

© 2015-2024
Devart. All Rights
Reserved.

Support Standard
v, ISO 92
v, ISO 92
v Deprecated
' Deprecated
Request Support ODBC Forum

Purpose
Closes the

connection.

Releases an
environment,
connection,

statement, or

descriptor handle.

Releases connection

handle.

Releases an

environment handle.

Provide Feedback

Using in Third-Party Tools

This section discusses how to use ODBC Driver for Twilio with ODBC-compliant tools.

e DBeaver

¢ Oracle Database Link

e Microsoft Access

e Microsoft Excel
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e OpenOffice and LibreOffice

* PHP
e Power BI
* Python

e QlikView

e SQL Server Management Studio

e SSIS

e Tableau

© 2015-2024
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DBeaver Overview

DBeaver is a free, open source multiplatform database management tool and SQL client for
developers and database administrators. DBeaver can be used to access any database or
cloud application that has an ODBC or JDBC driver, such as Oracle, SQL Server, MySQl,
Salesforce, or Mailchimp. Devart DBeaver provides you with the most important features
you'd need when working with a database in a GUI tool, such as:

e SQL queries execution

¢ Metadata browsing and editing

SQL scripts management

Data export/import

Data backup

e DDL generation

¢ ER diagrams rendering
¢ Test data generation

e BLOB/CLOB support
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¢ Database objects browsing

e Scrollable resultsets

The tool comes in two editions — Community and Enterprise. Enterprise Edition supports
NoSQL databases, such as MongoDB or Cassandra, persistent query manager database,
SSH tunneling, vector graphics (SVG) and a few other enterprise-level features. Note though
that you can access a MongoDB database from DBeaver Community Edition using the
respective Devart ODBC driver. For the purposes of this guide, we'll use the Community
Edition of DBeaver to retrieve data from Twilio via the Open Database Connectivity driver.

Creating an ODBC Data Source to Use Twilio Data in
DBeaver

1. Click the Start menu and select Control Panel.

2. Select Administrative Tools, then click ODBC Data Sources.

3. Click on the System DSN tab if you want to set up a DSN name for all users of the system
or select User DSN to configure DSN only for your account.

4. Click the Add button and double-click Devart ODBC Driver for Twilio in the list.

5. Give a name to your data source and set up the connection parameters.

6. Click the Test Connection button to verify that you have properly configured the DSN.

When using ODBC driver for Twilio with DBeaver, SQL_WVARCHAR data types may be
displayed incorrectly in DBeaver. To prevent this, you need to set the string data types to Ansi
either in the Advanced Settings tab of the driver configuration dialog or directly in the
connection string (String Types=Ansi) — all string types will be returned as SQL_CHAR,
SQL_VARCHAR and SQL_LONGVARCHAR.
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License  About

E

Ansi (SQL_CHAR, SQL_VARCHAR, SQL_LONG

[ ]Dates and times

Devart ODBC Driver Configuration
Gereral Advanced settings
Meta Data
Connection
-
Compatibility
ODBC Behavior Default
Siring Types
Use Local Regional Settings when converting to string
[ ] Mumbers
Test Connection

Cancel

Connecting to Twilio Data from DBeaver via ODBC

Driver for Twilio

Follow the steps below to establish a connection to Twilio in DBeaver.

1. In the Database menu, select New Database Connection.

49
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Yy DBeaver 6.1.5

Eile Edit Mavigate Search SOL Editor | Database Window Help

¢ | 9 | 7 I3 i 4 + % NewDatabase Connection
L]

_ ) =% Driver Manager
f® Database Mavigator i3 | [F Projects

¥ Connect

Invalidate/Reconnect
Enter a part of table name here

QODEC - xBase_xbd

Change Connection(s) Driver
ODBC - ZohoCRM_x64

&, ODBC - MailChimp_x64 Pisconned

£ ODBC - MongoDB_x64 Disconnect All

= ODBC - Oracle x64 20 compare/Migrate >
= ODBC - salesforceMC_x64 3 Tools ,
= ODEC - SugarCRM_x64 Context tools Al

2. In the Connect to database wizard, select ODBC and click Next.

fw Connect to database O >

(1

Select your database
ODBC bridge driver

Type part of database/driver name to filter & Gallery

Mame # ~
= ODBC 7
& Apache Ignite
5 AwWS
A Azure

3. Enter the previously configured DSN in the Database/Schema field.
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] atabhase D
Generic JDBC Connection Settings
. : = 0DBC
ODBC connection settings
General Driver properties SSH Proxy
JDBEC URL: ‘jdbc:Odbc:DBEAVER_DATASOURCE
Database/Schema: | DBEAVER_DATASOURCE |
User name: ‘ |
Passward: ‘ | Save password locally

4. Click Test Connection. If everything goes well, you'll see the Success message.

Viewing Twilio Database Objects and Querying Data

You can expand out the database structure in DBeaver's Database Navigator to visualize all
the tables in Twilio database. To view and edit the data in a table, you need to right-click on
the target table name and select View data.The content of the table will be displayed in the
main workspace.

ry DBeaver 6.1.5 - Solution
File Edit Mavigate Search SOLEditor Database Window Help
¢~ Ve |05 Tl ato |-

{= Databa.. 2 |[E@Projecs = O BB solution &2

v - | =< %Y = Properties | ] Data | 5 ER Diagram = ODB
Enter a part of table name here

FB siteDetail ~ | |PBsolution |23

=2 SitEF‘?Ed = solutionMame T3+ IsPublished
- S!tEHIStDW o % 1 GC1020 Portable Generator Switch Malfunctioning true

g zznlelii:znmewh|teL|stUrl Z Generator assembly instructions unclear false

M Solufionfesd § 3 | Maintenance guidelines for generator unclear false

M SolutionHistory s 4 | Selecting the Right Generator for Your MNeeds true

F® SolutionStatus 5 | GC3000 Series Propane Generator Ignition true

B Stamp @ | starting generator after electrical failure false

BB StampAssignment 7| Electrical wiring installation for GC5060 false

P StaticResaurce 8 | GenWatt SLA Commitments true

If you want to write a custom SQL query that will include only the necessary columns from the
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table, you can select New SQL Editor in the SQL Editor main menu. Create your query and

run it by clicking Execute SQL Statement to view the results in the same window.

= Databa.. 2 Projects — B | [T *<0ODBC > Script-5 &

“_ e | - = b SELECT SolutionMame, SolutionNote FROM Solution;

Enter a part of table name here b,
BB SiteDetail ~ |lop
FB SiteFeed = —
BB siteHistory B solution &2
™ siteiframeWhiteListUr T SELECT SolutionName, Solt | &2
FH solution
FE SolutionFeed = SolutionMame [ SolutionNote
BB solutionHistory % 1 | If the generator switch it
B8 SolutionStatus 2 | Generator assembly instructions unclear  The Maintenance Manu:
B8 stamp X 3 Maintenance guidelines for generator uncle The Maintenance Manuz
= StampAsmgnment '[_: 4 | selecting the Right Generator for Your Mee GenWatt offers a wide r
= 5tat|cF-{:.esource T s GC3000 Series Propane Generator Ignition The GC3000 series prog
= Stream!ngchannel & | Starting generator after electrical failure  After an electical failure,
: Stt;earr:ng.channelshare 7 | Electrical wiring installation for GC3060 The red wiring from the

Tabbe |n|t.|on B GenWatt SLA Commitments GenwWatt offers four diff

FB TabledVerify_ChangeEve — . .

( N = Electronic panel fitting loose On the GC3020, the elec

© 2015-2024

Devart. All Rights Request Support ODBC Forum Provide Feedback

Reserved.

4.2 Using in Oracle DBLink

Configuring Oracle Database Gateway for ODBC

This article explains how to configure Oracle Database Gateway for ODBC. If your data is
stored in a non-Oracle database system or cloud application, and you need to access it from
an Oracle Database server, you can create a database link to an Oracle Database Gateway
for ODBC. The gateway works with an ODBC driver to access non-Oracle systems or other,
remote Oracle servers. Any ODBC-compatible data source can be accessed using the
gateway and the appropriate ODBC driver. The driver must be installed on the same machine
as the gateway. The non-Oracle system can run on the same machine as the Oracle server
or on a different machine. The gateway can be installed on the machine running the non-
Oracle system, the machine running the Oracle database or on a third machine as a
standalone.
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Configure the Initialization File

After installing the gateway and the ODBC driver for Twilio, create an initialization file for your

Oracle Database Gateway for ODBC. The sample file initdg4odbc.ora is stored in the
ORACLE_HOME\hs\admin directory. To create an initialization file for the gateway, copy the
sample initialization file and rename it. The name must be prefixed with init — for example,
initTwilio.ora. You need a separate initialization file for each ODBC data source. After
creating the file, set the Hs_Fps_conNecT_1INFo parameter to the system DSN that you created
earlier, for example:

HS_FDS_CONNECT_INFO=Twil1io

Configure Oracle Net Listener

After configuring the gateway, you need to configure Oracle Net Listener to communicate with
the Oracle database. Information about the gateway must be added to the 1istener.ora
configuration file which is located in the orAcLE_HoME \NETWORK\ADMIN\ directory. The following
example is the address on which the Oracle Net Listener listens (HosT is the address of the
machine on which the gateway is installed):
LISTENER =

(DESCRIPTION_LIST =

(DESCRIPTION =
(ADDRESS = (PROTOCOL = TCP) (HOST = Tocalhost) (PORT = 1521))

)

Add an entry to the 1istener.ora file to start the gateway in response to connection requests.
The SID of the gateway (s1p_Name) must be the same in listener.ora and tnsnames.ora.
ORACLE_HOME is the Oracle home directory where the gateway resides. To apply the new
settings, stop and restart the Oracle Net Listener service.
SID_LIST_LISTENER=
(SID_LIST=
(SID_DESC=

(SID_NAME=Twi li0)

(ORACLE_HOME=D: \ORACLE_HOME)

(PROGRAM=dg4odbc)

)
)

Configure Oracle for Gateway Access

Add a connect descriptor for the gateway to the tnsnames.ora file, which is located in
ORACLE_HOME \NETWORK\ADMIN directory. The sip must match the value specified in the
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listener.ora file.
Twilio =
(DESCRIPTION =
(ADDRESS = (PROTOCOL = tcp) (HOST = localhost) (PORT = 1521))
(CONNECT_DATA =
) (SID = Twilio)
(HS = 0K)
Create Database Links
To access an ODBC data source, you must create a database link using a database tool like
SQL Plus or dbForge Studio for Oracle: connect to your database server and execute the
CREATE DATABASE LINK statement, as follows:
CREATE DATABASE LINK dbTink CONNECT TO "username" IDENTIFIED BY "paSSWO rd"
dblink is the complete database link name. tns_name_entry is the Oracle Net connect
descriptor specified in the tnsnames.ora file.
When you create the database link in dbForge Studio for Oracle, you can see your newly
created link in Database Links on the left panel. After creating the database link, you can run a
query against the ODBC data source using the following syntax:
SELECT * FROM table_name@"dblink_name"
See also
Configuring Oracle Database Gateway for ODBC
© 2015-2024
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4.3 Using in DBxtra

Troubleshooting Twilio ODBC Connection in DBxtra

This page explains how to troubleshoot your ODBC connection to Twilio in DBxtra.

Due to incompatibilities between DBxtra and Twilio, leaving the sQL dialect property to its
default might present various issues. To resolve compatibility issues, set the property to ms
Access 2000/XP/2003 or ANSI sqQL/20e3 for DBxtra version 11.0.1 or newer, and to ANSI
sqL/2ee3 for versions prior to 11.0.1.
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44

Connect through ODBC E3

NOTE:

Imiportant!

Due to incompatibles, selecting the Auto SQL dialect might present various
problems using the Auto SCL dialect with some database servers.

Please be sure to select the right SQL dialect for your connection.

Connection name |MyData

Data source |DataSource 1 III

User

Password

Connection timeout 15 : S0L dialect || M5 Access 20000 |w

Enable Offline Mode

Get columns descriptions
Select User Groups who can view this Connection

[#]accounting n
[]contraling

Guest Group

[~ILegal

Management

[#IManufacturing

[#Marketing

[Purchasing W

Select Al Unselect Al Cancel
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Using in Microsoft Access

Connecting Microsoft Access to Twilio Using an ODBC
Driver
This article explains how to connect Microsoft Access to Twilio through the standard ODBC

interface. Microsoft Access is a dababase management system that combines the relational
database engine with a graphical user interface. Access can be used as a substitution for
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spreadsheet applications like Excel to organize, store, and retrieve large amounts of related
data that can be difficult to manage in spreadsheets.

In Microsoft Access, you can connect to your Twilio data either by importing it or creating a
table that links to the data. Devart ODBC drivers support all modern versions of Access. lItis
assumed that you have already installed and configured a DSN for ODBC driver for Twilio.
For the purpose of this article, we tested an ODBC connection to Twilio through our ODBC

drivers in Microsoft Access 2003, Microsoft Access 2007, Microsoft Access 2010, Microsoft
Access 2013, Microsoft Access 2016, Microsoft Access 2019. The following steps describe
how to use Microsoft Access 2019 to import or link to your data in Twilio.

Importing Twilio Data Into Microsoft Access Through an ODBC
Connection
1. Open your Microsoft Access database.

2. Select the External Data tab in the ribbon.

3. Expand the New Data Source drop-down and select From Other Sources, then select

ODBC Dababase.

4. In the Get External Data - ODBC Database dialog box, select Import the source data

into a new table in the curent database, and click OK.
. In the Select Data Source dialog box, select the Machine Data Source tab.
. Select the DSN that you have configured for Twilio and click OK.

. In the Import Objects dialog box, select the tables that you want to import, and click OK.

0 N O O

. If the database objects have been successfully imported, you should the see the
corresponding message in the dialog box. If you want to save the import steps to quickly
repeat the process without using the wizard at a later time, select the Save import steps

checkbox. Click Close.
9. The imported tables should appear in the Tables navigation pane on the left.

10.Double-click on the needed table to display its contents.

Linking to Twilio Data in Microsoft Access Through an ODBC
Connection
1. Open your Microsoft Access database.
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2. Select the External Data tab in the ribbon.

3. Expand the New Data Source drop-down and select From Other Sources, then select
ODBC Dababase.

4. In the Get External Data - ODBC Database dialog box, select Link to the data source
by creating a linked table.

5. In the Select Data Source dialog box, select the Machine Data Source tab.

6. Select the DSN that you have configured for Twilio and click OK.

7. In the Link Tables dialog box, select the table or tables that you want to link to, and click
OK.

8. The Select Unique Record Identifier dialog box will prompt you to choose a field or fields
that uniquely identify each record in the table. To avoid inconsistencies, it is recommended
to select the primary key in the Twilio table as the unique record identifier. You are linking

multiple tables, you will be prompted to select unique record identifiers for each of the

selected tables.
9. The linked tables should appear in the Tables navigation pane on the left.

10.Double-click on the needed table to display its contents.
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4.5 Using in Microsoft Excel

Connecting to Twilio from Microsoft Excel using ODBC
Driver for Twilio

You can use Microsoft Excel to access data from a Twilio database using ODBC connector.
With ODBC Driver, you can import the data directly into an Excel Spreadsheet and present it

as a table. Make sure that you use matching Excel and ODBC Driver, e.g. if you have
installed a 64-bit ODBC Driver, you will need to use the 64-bit version of Excel.

When working with Microsoft Excel, there are different ways of retrieving data from various
data sources using our ODBC drivers.

e Connecting Excel to Twilio with Get & Transform (Power Query)
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e Connecting Excel to Twilio with Data Connection Wizard (Legacy Wizard)

e Connecting Excel to Twilio with the Query Wizard

e Connecting Excel to Twilio with Microsoft Query

e Connecting Excel to Twilio with PowerPivot

Connecting Excel to Twilio with Get & Transform (Power
Query)

You can use Get & Transform (Power Query) to connect to Twilio from Excel with ODBC.
This method assumes that you've installed an ODBC driver for Twilio.

1. Click the Data in Excel, then expand the Get Data drop-down list. Click From Other
Sources > From ODBC.

H Bookl - Excel Evgeniy Lemeshov 2| |
File Home Insert Page Layout Formulas Review View Help @ Tell me 9 Share
HLEE A A
B.. s & El 2 i
=1 [ - .
Get Refresh z| Sort Filter Text to What-f Forecast Outline
B = Y, = - B -
Data - All - i Columns =2 Analysis = Sheet M
Gi Sort & Filter Data Tools Forecast L
ﬁ From File L
c b
T
From Database s - - - - t ' ; =
— 1 3
Ay m - | + 100%
= am From Azure 4 From Table/Range
L=y
__E) From Online Services » _@ From Web
B =
_.¢. From Qther Sources L4 _ From Microsoft Query
B
\_)r"j Combine Queries 4 _.¢. From QDEC

2. In the From ODBC dialog, choose your data source name (DSN). If you haven't configured
your ODBC driver yet, you can expand the Advanced Options dialog box and enter the

connection string for your data source (without credentials, which are defined in the
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credentials dialog box in the next step). Additionally, you can enter an SQL statement that

will be executed right after establishing a connection to the data source. Click OK.

From ODBC

Data source name (DSN)

| Devart ODBC Dniver b

4 Advanced options
Connection string (non-credential properties) (optional) &

501 statement (optional)
SELECT * FROM MyDatabase.MyTable;

Supported row reduction clauses (optional)
(Mone) = Detect

3. If you're using a database username or password, select Database and enter your

credentials in the dialox bog, then click Connect.
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ODBC driver X
Default or Custom < dsn=Devart ODBC Driver
. Use a username and password to access a data source with an ODEBC driver,

Windows

User name
Database myusername

Password

SR NeREeE

Credential connection string properties (optional) (0

Back Cancel

If your database is not password-protected or you've already specified your credentials in the
ODBC data source settings, select Default or Custom and press Connect

Default or Custom ¢'d5”: evart ODBC Driver

Wind Don't specify any credentials or only connection string properties.
indows

Credential connection string properties (optional) (O
Database

Back Cancel

4. In the window that appears, select the table you want to retrieve data from, and click Load.
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O X
Navigator
yel

Select multiple items
Display Options ~ Dﬂ
4 F ODBC (dsn=0DBC Driver for 5... A

] AcceptedEventRelation . .

? No item selected for preview

B Account

B AccountChangeEvent

B AccountCleaninfo

B AccountContactRole

B AccountContactRoleChange...
Select Related Tables load |~ Edit Cancel

The data from the table will be a displayed in an Excel spreadsheet where you can further
work with it.

H ©- Book1 - Excel Table... = - B x
File Home ‘ Insert | Page La | Formul: | Data | Review | View ‘ Design ‘ v Tellme. Evgeniy.. S Share
Al - f;r w
D E F G H -
1N SolutionName ﬂ IsPublished n IsPuhIisI’ﬂ Status ﬂ IsReviewed ﬂ §
2 |GC1020 Portable Generator Switch Malfunctioning 1 0 Reviewed 11
3 |Generator assembly instructions unclear 1] 0 Draft [
4 |Maintenance guidelines for generator unclear 1] 0 Draft 0T
5 |Selecting the Right Generator for Your Needs 1 0 Reviewed 1/d
6 |GC3000 Series Propane Generator Ignition 1 0 Reviewed 1T
7 |Starting generator after electrical failure 1] 0 Draft o n
8 |Electrical wiring installation for GC5060 1] 0 Draft 0T
9 |GenWatt SLA Commitments 1 0 Reviewed 1/
10 |Electronic panel fitting loose 0 0 Draft 0 C

Sheet1 ) 1 »

Connecting Excel to Twilio with Data Connection Wizard
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(Legacy Wizard)

You can use this option to connect to OLE DB or ODBC external data source that has
already been defined.

1. In Excel, go to the Data tab. Click From Other Sources, and then click From Data

Connection Wizard.
2. In the opened dialog, select ODBC DSN and click Next to continue.
3. Now select a data source you want to connect to, and click Next.

4. To connect to the table containing the required data, select its name and click Next to enter

and save information about your new file or click Finish.

5. In the Import data dialog, you can select the way your data will be viewed in Excel and the

place where to put it in the worksheet, and click OK.

6. The required data is now displayed in the existing Excel worksheet.

Connecting Excel to Twilio with the Query Wizard

You can use this option to create a simple query for retrieving data from Twilio to Excel via
ODBC driver.

1. Open Excel, in the main menu, click the Data tab.
2. Click the From Other Sources dropdown menu, and then click From Microsoft Query.
3. In the appeared dialog, you can choose the data source you want to connect to.

4. After a successful connection, you can select the data you want to be displayed in Excel

and click Next.
. The next two steps allow filtering and sorting the data. Click Next to skip these procedures.
. If you plan to further use the query, you can save it by clicking the Save button on the right.

. Select Return Data To Microsoft Excel and click Finish.

0 N O O

. In the Import data dialog, you can select the way your data will be viewed in Excel and the

place where to put it in the worksheet, and click OK.

9. The required data is successfully imported to Excel.

Connecting Excel to Twilio with Microsoft Query
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You can use this option to create a more complex query for retrieving Twilio data to Excel via
ODBC driver.

1. Start Excel, click the Data tab.

2. In the appeared ribbon, click From Other Sources, and then click From Microsoft Query.

3. In the next dialog, choose the data source you want to connect to (e.g., using data source
name - Devart ODBC Twilio). Uncheck Use the Query Wizard to Create/Edit Queries
and click OK.

4. Now you can select the tables you want to add to your query. When you finish, just click
the Add button.

5. In the graphical editor, you can filter rows or columns of data, sort data, join multiple tables,

create a parameter query, etc.

Connecting Excel to Twilio with PowerPivot

You can use PowerPivot - an Excel add-in to perform data analysis and create complex data
models. To load the required data, do the following:

1. In Excel, click the PowerPivot tab, then click Manage to go to the PowerPivot window.

2. In the opened window, click From Other Sources.

3. When the Table Import Wizard opens, select Others (OLEDB/ODBC) and click Next.

4. In the Specify a Connection String window, click the Build button.

5. In the Data Link Properties dialog, specify the data source you want to connect (e.g.,
using data source name - Devart ODBC Twilio), and then click Next.

6. Now you should choose how to import the data (either select a table from the list or write a
query to specify the data to be imported).
7. When the Import operation succeeded, click the Close button. The retrieved data is

inserted in the active worksheet.

© 2015-2024
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4.6

461

Using in SQL Server Management Studio

This section describes how to establish and troubleshoot a connection to Twilio from SQL
Server Management Studio using ODBC Driver for Twilio.

¢ Creating a Linked Server

¢ Troubleshooting in SSMS

© 2015-2024
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Creating a Linked Server

Requirements

In order to avoid incorrect integration with MS SSMS, the working environment must meet the
following conditions:

¢ The data source must be a configured system DSN. Refer to the Driver Configuration

article to learn how to configure a System DSN

e The driver, studio, and SQL Server must be of the same bitness. For example, if you are
using 64-bit SQL Server Management Studio on 64-bit Windows platform, then configure
the 64-bit version of the driver using ODBC Administrator launched from %windir%
\system32\odbcad32.exe. Otherwise, configure the driver using the 32-bit version of ODBC
Administrator - launch it from %windir%\SysW OW64\odbcad32.exe.

e ODBC Diriver for Twilio and SQL Server must be installed on the same computer.

e NET Framework 4.5 must be installed on the computer.

Connecting to Twilio from SQL Server Management
Studio using ODBC Driver for Twilio

You can use the Microsoft SQL Server Management Studio to connect your Twilio data to an
SQL Server instance. Linked Server is a tool of MS SQL Server that allows to execute
distributed queries to refer tables stored on non-SQL Server datbase in a single query. With
linked servers, you can execute commands against different data sources such as Twilio and
merge them with your SQL Server database. You can create a linked server with one of these
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methods: by using the options in the Object Explorer or by executing stored procedures.
Below are major advantages of using SQL Server Linked Servers to connect to Twilio:
1. The ability to connect other database instances on the same or remote server.

2. The ability to run distributed queries on heterogeneous data sources across the
organization.

3. The ability to work with diverse data sources in the same way.

How to configure a SQL Server Linked Server to connect
to Twilio

You can follow the steps to create a linked server for Twilio in SQL Server Management
Studio by using Object Explorer:
1. Start your Management Studio and choose your SQL Server instance.

2. In the Object Explorer pane, expand the Server Objects, right-click on Linked Servers
and then click on New Linked Server.
3. Configure your linked server in the dialog box:
¢ Give a name for your server in the Linked server field.
e Under Server type, select Other data source .
e Choose Microsoft OLE DB Provider for ODBC Drivers in the Provider drop-down
list.
¢ |n the Data source field, enter the name of your DSN, e.g. Devart ODBC Driver for
Twilio . Alternatively, you can input the ODBC Driver connection string in the Provider

field.

The linked server will appear under the Linked Servers in the Object Explorer Pane. You can
now issue distributed queries and access Twilio databases through SQL Server.

Retrieving Data From Twilio

Ensure the Allow inprocess option of MSDASQL OLE DB Provider for ODBC Drivers is
enabled. For this, find the MSDASQL provider in the list of Linked Servers and double-click on
it
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Chject Explorer
Connect~ ¥ ¥

(WIS

= I x

Databases
Security
= Server Objects
Backup Devices
= Linked Servers
B Providers
@8 ADsDSOObject
wE MSDAOQSP
wh MSDASQL
wh MSOLAP
wE MSOLEDBSQL

wh search.CollatorDs0O

= @ EVGENIYL\SQLEXPRESS (SQL Server 14.0.1000 - C

In the appeared Provider Options window, enable the Allow inprocess checkbox:

@E Provider Options - Microsoft OLE DB Provider for ODBC Drivers

Select a page

& General L7 scipt ~ @ Hep

Provider options:

Enable MName

U
U
[]

Lienlemed mmmamen s amimem dhin messicd e

Create a new Linked Server

[Cynamic parameter
MNested queries
Level zero only
Allow inprocess
Maon transacted updates
Index as access path
Disallow adhoc access
Supports "Like’ operator ¥
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Object Explorer * I X
Connect~ ¥ ¥ VIS
= @ EVGEMIYL\SQLEXPRESS (SCL Server 14.0.1000 - DATASOFT
Databases
Security
= Server Objects
Backup Devices

c

Providers ( Mew Linked Server...
Triggers Start PowerShell
Replication
PolyBase Reports ’
Management Refresh

HEvent Profiler

£

Make sure to select Microsoft OLE DB Provider for ODBC Drivers:

H New Linked Server = O *
Selecta page HSGI‘iDt"ﬂHeIp
# General
& Security
& Server Options b
Server type:
() 5QL Server

(®) Other data source

Pravider: Microsaft OLE DB Provider far ODBC Drivers w

Product name:

Data source:

Location

| |
| |
Provider string: | |
| |
| |

Catalog

Connechon

Now you need to input the Linked Server name, e.g. TWILIO. In the Product Name and Data
Source fields you need to indicate the System DSN that you've previously created - more info
on System DSN setup can be found here.
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¥ New Linked Server - U .
Selecta page IT Scipt ~ @) Help
& General
& Securty
& Server Options Linked server: TWILIO
Servertype:
() 5QL Server

© Other data source

Provider: Microsoft OLE DB Provider for ODBC Drivers w
Product name: Devart ODBC Driver for Twilio

Data source: TWILIO

Provider string:

Location

Catalog

The Twilio tables are already available to be fetched. To query the linked server, click New
Query in the toolbar:

File Edit View Project SOL Complete Tools Windoy
O 0@ 0 -2 K | BNewauey B R @

| | Execute

Object Explorer * 0 X
Connect~ ¥ ¥ ¢ »

= E EVGEMIYLA\SQLEXPRESS (5QL Server 14.0.1000 - DATASOFT
Databases
Security
= Server Objects
Backup Devices
:
Providers
H ORACLE
B rPosSTGRESQOL
B saute

BEEEE

Enter your SQL query in the editor window and click Execute to run the query:
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4 SQlQueryd.sql - EVGENIYL\SQLEXPRESS.master (sa (54))* - Microsoft SQL Server Management St., | Quick Launch (Ctri+Q) =S
File Edit View Query Project SOL Complete Tools Window Help
(oo @y -t BNy RS RD | XFD|2-C-[Bs e

4l

“f | master - | P Execute v ES | 2" s i_“||m'?i|m'—:|| BRI
— —
Object Explorer SQLQueryé.sql - E..S.master (sa (54))* +# X
Connect ~ ¥ K* 6 "y -] SELECT * FROM [SURVEYMONKEY]...[ListMembers]; %
Fs
5 AMAZON REDSHIFT ~ 3
B ase
B BIGCOMMERCE
B pynamics -
100% -
5 FReBRD
B FRESHBOOKS B Resuts E Messages
§ INTERBASE L Email Listld EmailType  Status CreatedDate
B MAGENTO 1 1262812041 : dacl0@devat.com  2c7adbdbefl  Text Subscribed 2018-12-24 10:44:18.0000
=] q SURVEYMONKEY 2 262812045  hello10@devat.com  ZciaBbdbel  Tedt Subscribed 2018-12-24 10:44:15.0000
E Catalogs 3 262812045  mail10@devart.com 2c7aBbdbef  Html Subscribed 2018-12-24 10:44:15.0000
4 262812053  sales10@devart.com 2cTafbdbefl  Text Subscribed 2018-12-24 10:44:20.0000
System Catalogs = = :
5 @ default 5 262812057  test10@devart.com Zciadbdbefl  Text Unsubscrbed  2018-12-24 10:44:22 0000
Tables
Views
< >
v
< > 0 Query execute... | EVGENIYL\SQLEXPRESS (14.0 RTM) | sa (54) | master | 00:00:13 | 5 rows

As a result, you can see the contents of the selected table retrieved directly from the Twilio
account you are connected to.

See also
e Troubleshooting SSMS
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46.2 Troubleshooting in SSMS

When creating a linked server in SSMS, most errors happen due to security issues with
DCOM class MSDAINITIALIZE. We need to alter the DCOM Class MSDAINITIALIZE security
settings to make it work.

Following are the steps:

1. Open Component Services (Start>Run>DCOMCNFG)

2. Expand Component Services>Computers>My Computer>DCOM Config

3. From the list of DCOM components on the right side, select MSDAINITIALIZE and go to its
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properties:

-
%. Component Services

. File Action

View Window Help

Console Root
4 . Component Services
a [ Computers
4 (& My Computer

» [ COM+ Applicatio
1 (] DCOM Config
& [ -] Running Processe
& [ Distributed Trans:
I E Ewvent Viewer (Local)
3 f.a Services (Local)

Windows... Windows R... Windows R...
Microsoft Microsoft Microsoft Microsoft
Windo... Windows ...  WMIPro.. WMIProvi...

¥ & & @&

Micrasoft... Microsoft.L.. MicroseftV... Microsoft..

ApplD
MMC ALY MSMDPP - MsRdpbess...
Applicati... LIZE

¥ ¥ & @

MSTTS Mahimicse.. MAP Agent Map Elevated
DecObj Cla... Service COM class
NCLUA MDFAPI netman netprofm

¥ ¥ & @

MetProjW  Metwork and  Offline Files  OpenSearch
Sharing Ce... Service Description...

More Actions 4

4. Go to the Security Tab, Choose ‘Customize’ and click on the ‘Edit’ Button:
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F B
MSDAINITIALIZE Properties L2 ||

| General | Location | Securty | Endpoirts | Idertity |

Launch and Activation Permissions
(71 Use Default

i@ Customize

Access Permissions

(71 Use Default

i@ Customize

Corfiguration Pemissions
(71 Use Default

i@ Customize

Leam more about setting these properties.

[ OK ][ Cancel ] Apply

5. Add the Domain User who is accessing the linked server and ‘Allow’ all the permissions
available (Local Launch, Remote Launch, Local Activation, Remote Activation). If you are
connecting to SQL server using SQL account, you need to provide this permission to the

account under which the SQL service is running.

6. Do this for all the 3 sections in the above screenshot.

To edit the Security settings, we followed the below steps:

1. Start > Run > Regedit

2. Find the Key: HKEY_LOCAL_MACHINE\SOFTWARE\Classes\AppID\{2206CDB0-19C1-
11D 1-89E0-00C04FD7A829}
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3. Right Click>Permissions>Advanced>Owner Tab:

-

| Advanced Security Settings for {2206CDEQ-19C1-1101-89E0-00C04AFDTAB2S}

sgiii

Pemissions I Auditing | Owiner | Effective Permissions

Current owner:

< - s i = iy et o -

Change ownerta:

You can take or assign ownership of this object f you have the required permigsions or privileges.

Name

Cither users or groups...

[7] Beplace owner on subcontainers and objects

e e e o P A At

Leam about ohject ownership

. R e e r oy T R R PP 0.

4. Change the owner to Administrators.

5. Now, grant ‘Full Control’ to Administrators:
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-

-
. Permissicns for {2206CDE0-19C1-1101-89E0-00C04F... M

Securty

Group or user Names:
QJ__NETWDHK SERVICE £

E4d Administrators {0 0
52, Users | “Users)

82 Trustedinstaller s
1| 1] bareals

Pemissions for Administrators Allow Dery

Full Cortrol O
Read 0

Special permissions

For special pemissions or advanced settings,
click Advanced. =

Leam about access contral and permissions

ok ] [Cance 7] [ oy

After this you should be able to edit MSDAINITIALIZE security settings .

See also
e Error message when you try to create an instance of an OLE DB provider in SQL Server:
"Cannot create an instance of OLE DB provider"
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4.7 Using in OpenOffice and LibreOffice

Connecting to Twilio from OpenOffice and LibreOffice
using ODBC Driver for Twilio
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The article describes how to use Apache OpenOffice and LibreOffice to access ODBC data
sources using the respective driver. You can access Twilio data from Open Office Base or
LibreOffice Base — desktop database management systems. Note that the Windows version
of OpenOffice is 32-bit, and you may get the error “The specified DSN contains an
architecture mismatch between the Driver and Application” when trying to access a data
source through a 64-bit ODBC Driver. To get rid of the error message, set up the 32-bit
version of the driver.

To connect to an ODBC data source from OpenOffice or LibreOffice using our driver for
Twilio, perform the steps below:

1. Start OpenOffice or LibreOffice, click Database to open the Database Wizard.

Apache i ™
€5 OpenOffice™ 4

‘E Text Document; Drawing
Spreadsheet EE] Database
Presentation E Formula

@ Open... = |_r/_| Templates..

Alternatively, you can launch the Database Wizard from OpenOffice or LibreOffice Calc,

Writer or any other tool by choosing File > New > Database.
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iZ| Untitled 1 - O penOffice Writer

File Edit Wiew |nsert Format Table Tools Window Help

EI Mew 3 E Text Document Ctri+mM & -
2 Open.. Ctrl+O | & Spreadsheet ol
Recent Documents 3 @ Presentation S
i i PR
(3, Wizards » | T€ Drawing
@ Database
(B Close
H save Ctrl+S @ HTML Document
B saveas. Ctrieshiftes | 2 XML Form Document
Save All E Master Document
Reload ] Formula
Versions... i Labels
[& Export... iz Business Cards
Export as PDF... £, Templates and Documents
Send 3 |

2. In the Database Wizard dialog box, click Connect to an existing database, select

ODBC from the drop-down list, and click Next.
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Database Wizard

Steps Welcome to the OpenOffice Database Wizard
1.5elect database Use the Database Wizard to create a new database, open an existing database file,
2.Set up ODBC connection or connect to a database stored on a server.

3.5et up user authentication

4.5ave and proceed

What do you want to do?
(0 Create a new database

O Open an existing database file

Recently used

|Ne-.'—.- Database2

=5 Open...

(® Connect to an existing database

QODBC s
Help << Back | Mext == | Finish Cancel

3. Specify the name of the data source you want to connect to. You can either type the name

of your data source into the field, e.g. ODBC Driver for Twilio, or you can click Browse,

double-click the data source you need, and then click Next.

Database Wizard

Steps Set up a connection to an ODBC database

1. 5elect database Enter the name of the ODBC database you want to connect to,

Click 'Browse...' to select an ODBC database that is already registered in OpenOffice.

Please contact your system administrator if you are unsure about the following
settings.

Set up ODBC connection

3.5et up user authentication

4, Save and proceed

Mame of the ODBC data source on your system

Browse
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Data Source *
Choose a data source: oK
Devart ODBC Driver
Devart ODEBC Driver for SQLite_32 Cancel
Devart ODBC Driver_32bit
QDBC Driver for MySQL_32bit Help
QOrganize...
Database Wizard e
Steps Set up a connection to an ODBC database
1.Select database Enter the name of the ODBC database you want to connect ta.

Click 'Browse...' to select an ODBC database that is already registered in OpenOffice.

o Please contact your system administrator if you are unsure about the following
3.5et up user authentication settings.

2.5et up ODBC connection

4.Save and proceed

MName of the ODBC data source on your system

Devart ODBC Driver_32bit

Help << Back Mext == Einish Cancel

4. If your database requires a user name, type it into the User name field. If you are
connecting to a password protected database, check the Password required field.

Alternatively, you can specify these parameters in the data source settings of your ODBC
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Driver for Twilio and leave these fields empty in Database Wizard.

Database Wizard

Steps

1.5elect database
2.5et up ODBC connection

3. Set up user authentication

4.Save and proceed

Help

Set up the user authentication

Some databases require you to enter a user name.

User name myusername

Password reguired

Test Connection

<< Back Mext == Finish Cancel

To test the connection to your data source, click Test Connection, input your credentials

and click OK.
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= L L

Authentication Required ¥

Steps

1. Select database MESSEQE from server:

2.5et up ODBC connection A password is needed to connect to the data source .

3. 5et up user authentication

4. 5ave and proceed

Enter user name and password for:

User name
myusername

Password

—

Help Ok Cancel

Test Connection

Help << Back Mext = Finish Cancel

If you have entered valid credentials, you will see a success message. Click Next to proceed

to the final step.

5. You can keep the default selection in this dialog box and click Finish.
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Database Wizard

Steps

1.5elect database
2.5et up ODEC connection

3.5et up user authentication

: .ESEWE and proceed

Help

Decide how to proceed after saving the database

Do you want the wizard to register the database in OpenOffice?

® Yes, register the database for me

(O Mg, do not register the database

After the database file has been saved, what do you want to do?
Open the database for editing
[] Create tables using the table wizard

Click 'Finish' to save the database.

<< Back Mext = Einish Cancel

You will be prompted to give a name to your new database and select the directory where you

want to store it.
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S save &s
« o v
Organize -

& This PC

M 3D Objects

B Deskiop

|j_: Documents

4 Downloads

D Music
&=| Pictures
B videos

- Mew Volume ([v <€

File name: | Mew Databaze

Save as type: | ODF Database

- Hide Folders

@ Mew Database

i Local Disk (C2)

v O Search DB

Date modified Type

81

05.06.2019 16:43 OpenDocumer

Automatic file name

Save Cancel

6. When the database opens, you will see the list of tables from your data source diplayed in

OpenOffice or LibreOffice Base workspace. To view the data from a specific table, double-

click the table name.
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Mew Databasel16.odb - OpenOffice Base = O X
File Edit View Insert Tools Window Help x
‘R-@-u N EIERCY HEEERET

E Create Table in Design View.. Description
& Use Wizard to Create Table...

ueris

AcceptedEventRelation " None =
= Account
Lorms AccountChangeEvent
AccountCleaninfo
AccountContactRole
Reports AccountContactRoleChangeEvent
£ solution - New Database162 - CpenOffice Base: Table Data View = O x

File Edit View |nsert Tools Window Help

B Ko WS- BRIRT v ¥

[ |GC1020 Portable Generator Switch Malfunctioning

Generator assembly instructions unclear
Maintenance guidelines for generator unclear
Selecting the Right Generator for Your MNeeds
GC3000 Series Propane Generator Ignition
Starting generator after electrical failure
Electrical wiring installation for GC5060
GenWatt SLA Commitments

Electronic panel fitting loose

GenWatt Installation Services

SolutionName | IsPublished | IsPublishedinPublickb | Status | IsReviewed | SolutionNote | O
] O Reviewed ] If the generator 005!
O O Draft O The 005:
O O Draft O The 0051
%] O Reviewed 1 GenWatt offers | 005:
] O Reviewed ] The GC3000 005:
O O Draft O After an 005]
O O Draft O The red wiring  005:
M O Reviewed ] GenWatt offers | 003:
O O Draft O On the GC3020, 005!
%] O Reviewed 1 GenWatt 0057

7. To create an SQL query, click Queries in the Database pane, then click Create Query in

SQL View...
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MNew Database.odb - OpenOffice Base -

Eile Edit Wiew [Insert Tools Window Help

B3 - E-@y ]
[ Create Query in Design View... Description
\E= (& Use wizard to Create Query Create a query entering an SQL statement dirs

Tables |§&|. Create Query in SQL View... |
F
EEE

i

ﬁ

Forms |

Enter your query in the query text box and click Run Query (F5). The date will be fetched

from the database and displayed in Open Office or LibreOffice, respectively.

£ New Databasel6.0db : Query1 - OpenOffice Base: Query Design — O X
File Edit Miew [nsert Tools Window Help

FIEIETT I i |

2| % M- HRIRT v
SolutionName | IsPublished | IsPublishedinPublickb | Status | IsReviewed | SolutionNote
b |GC1020 Portable Generator Switch Malfunctioning O Reviewed If the generator |0
Generator assembly instructions unclear | O Draft | The 0
Maintenance guidelines for generator unclear l O Draft [l The ]
Selecting the Right Generator for Your Meeds O Reviewed GenWatt offers |0
GC3000 Series Propane Generator Ignition O Reviewed The GC3000 o
Starting generator after electrical failure l O Draft [l After an ]
Electrical wiring installation for GC3060 [l O Drraft [l The red wiring 0
GﬂTWatt SLA Commitments M M Reviewed M GenWatt offers |0
Record |1 [ of 10 mEle sl < >
SELECT * FROM Solution;
Devart. All Rights Request Support ODBC Forum Provide Feedback
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4.8 Usingin PHP

Connecting to Twilio from PHP using ODBC Driver for
Twilio

© 2024 Enter your company name


https://www.devart.com/company/contactform.html?category=0&product=odbc/twilio
https://support.devart.com/portal/en/community/odbc-drivers
https://www.devart.com/odbc/twilio/feedback.html

84

ODBC Driver for Twilio

PHP is one of the most popular programming languages for website development. ODBC
drivers are connectors that make PHP development database agnostic — your software
written in PHP will function with any vendor's database management system. You can use
functions like odbc_exec() to prepare and execute SQL statements against any databases
like MySQL, SQLite, PostgreSQL, etc.

PHP-based projects usually require a data storage, whether a traditional database or a cloud-
based database. You can establish a connection to them using ODBC interface. With our
ODBC drivers, you can access various data sources and retrieve tables and fields from a
database.

Below is a sample PHP script for accessing Twilio via ODBC. The script connects to Twilio

database and fetches all records from a table:

Step 1: Connect to ODBC data source

The odbc_connect() function is used to connect to an ODBC data source. Note that the
function takes three mandatory parameters: the data source name, username and password.
If your database is not password-protected or doesn't require a username, leave these
parameters empty. In the following example, a connection is established using the
odbc_connect() function in PHP.

<?php
$user = "myusername";
$password = "mypassword";

$oDBCConnection = odbc_connect("DRIVER={Devart ODBC Driver for Twilio};A

Step 2: Execute an SQL statement

If connection is successful, the odbc_exec() function is used to execute a SELECT
statement against the dept table in the autotest database.

$sQLQuery = "SELECT * FROM autotest.dept";
$Recordset = odbc_exec($0ODBCConnection, $SQLQuery);

Step 3: Print the result set

The odbc_fetch_row() function is used to return records from the result set. While
odbc_fetch_row() returns rows, the odbc_result_set() function prints a set of result in HTML
table. After all rows from the result set have been printed, the odbc_close() function closes
the connection.

while (odbc_fetch_row($Recordset)) {
$result = odbc_result_all($RecordSet, "border=1");
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4.9

odbc_close($0DBCConnection);
7>

You can modify this script by specifying general settings for each Devart ODBC driver to use

any of them with your PHP projects.
© 2015-2024
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Using in Power Bl

Importing Twilio Data into Power Bl Through an ODBC
Connection

Power Bl is a popular business intelligence solution that is comprised of services, apps, and
connectors that allow you to pull raw data from various sources and create meaningful
reports. To connect Power Bl to a data source such as Twilio, you can use a corresponding
ODBC driver.

This tutorial explores how to connect to Twilio and import data into Power Bl Desktop using
an ODBC driver. It is assumed that you have already installed and configured a DSN for
ODBC driver for Twilio.

1. Run Power Bl Desktop and click Get Data.

2. Select the Other category in the Get Data dialog box, then select ODBC. Click Connect
to confirm the choice.

3. In the From ODBC dialog box, expand the Data Source Name (DSN) drop-down list and
select the previously configured DSN for Twilio

4. If you would like to enter a SQL statement to narrow down the returned results, click the
Advanced options arrow, which expands the dialog box, and type or paste your SQL
statement.

5. Click OK. If your data source is password-protected, Power Bl will prompt you for user
credentials. Type your Username and Password in the respective fields and click.

6. Now you should see the data structures in your data source. You can preview the contents
of the database objects by clicking on them.

7. To load the Twilio data into Power Bl for analysis, select the needed table and click Load.
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410 Using in Python

Installing the ODBC Driver for Twilio

One of the most convenient methods to connect to an external database or access cloud
data from Python is via ODBC. Devart has developed a range of ODBC Drivers for Python to
work with databases and cloud services.

If you don't have Python installed on your machine, go to the Python official website, download
the appropriate installer and run it. You will also need to install the pyodbc module — the
easiest way to do that is by using the pip install pyodbc command in the Python interactive
mode. Next, you need to download the ODBC Driver for Twilio. To use the ODBC driver as a

translation layer between the application and the database, you need to configure it by
following the installation instructions.

Connecting to Twilio from Python using ODBC Driver for
Twilio

Here’s an example to show you how to connect to Twilio via Devart ODBC Driver in Python.

First we import the pyodbc module, then create a connection to the database, insert a new
row and read the contents of the EMP table while printing each row to the Python interactive
console. To execute the script, you can type the code directly in the interactive console or add
the code to a file with the .py extension and run the file from the command prompt.

Step 1: Connect

import pyodbc _ o
cnxn = pyodbc.connect('DRIVER={Devart ODBC Driver for Twilio};Account SID=YoO

Step 2: Insert a row

Here's a simple example of how to execute an insert statement to test the connection to the
database. The script inserts a new record to the EMP table.

cursor = cnxn.cursor()
cursor.execute("INSERT INTO EMP (EMPNO, ENAME, JOB, MGR) VALUES (535, 'Scott

Step 3: Execute query
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The cursor.execute() function retrieves rows from the select query on a dataset. The
cursor.fetchone() function iterates over the result set returned by cursor.execute() while the
print() function prints out all records from the table to the console.

cursor = cnxn.cursor()
cursor.execute("SELECT * FROM EMP")
row = cursor.fetchone()
while row:
print (row)
row = cursor.fetchone()
© 2015-2024
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411 Using in QlikView

Connecting to Twilio from QlikView using ODBC Driver
for Twilio

This tutorial describes how to connect and configure QlikView to retrieve data from Twilio for
further analysis. QlikView is a data visualization tool that connects and pulls data from
different popular databases like MySQL, MongoDB, Oracle, SQL Server, Postgres, etc. to
present it in a single view. The business intelligence platform identifies relationships in your
data and discovers patterns and opportunities to support your decision making.

QlikView supports the ODBC connectivity interface for communication with external data

sources. An ODBC data source must be configured for the database you want to access.
You can create an ODBC connection using a DSN during the ODBC driver installation or

later.

To connect to an ODBC data source from QlikView using our driver for Twilio, perform the
steps below:

1. Open the QlikView client application and click File > New. Close the Getting Started
wizard and open File > Edit Script (CTRL+E).

© 2024 Enter your company name


https://www.devart.com/company/contactform.html?category=0&product=odbc/twilio
https://support.devart.com/portal/en/community/odbc-drivers
https://www.devart.com/odbc/twilio/feedback.html

88

ODBC Driver for Twilio

@ qlikview x64 Personal Edition - [av1]

{| File | Edit View Selections Layout Settings Bookmarks Reports Tools Object Window Help
{0 New Ctri+N || & | #a| v | [ | @) |5? B ¢ K Clear ~| @ Back &) Forward | & Lock &' Unlock
= open.. Ctrl+0
= Open in Server.. Ctrl+Shift+O
Open URL...
Open FTP...
Close
Favorites »
= save Ctrl+5
Save As... F12
Mail as Attachment...
Mail with Bookmark as a Link
| P . +P
Print Sheet...
Source Control »
Export »
| 4 Edit script... arl+e |

2. In the Data tab, choose ODBC from the Database drop-down and click Connect. Select
the Data Source you created earlier, type in the User ID and Password if your database is
password-protected. You can test the connection by choosing Test Connection. The
Connection Test succeeded message should appear. Click OK to connect to your data

source.
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V]
File Edit Insert Tab Tools Help
-l Reload #Debug | [ S| & -2 @] O [0 <1 2 Tabs Main v |23 =

[GET

@ Connect to Data Source s

User ID Pazswond

|m_l,.lid | | sesee| |

Canecel

Data Sources

Help

i}
Devart ODEC Drriver for ASE
Drewart ODBC Driveer for Firebird
Devart ODBC Driver for Interbase
- - - Devart ODBLC Driver for bMagento
Dats  Functions Variables  Settings Dievart ODBC Ciriver for MaiChimp
. Diewart ODBC Diriver for MySEIL
Database Diata from Files | | Devart ODBC Driver far MetSuite
. Dewart ODBC Driver for Oracle

| el ~ Connect... L] Relative Faths Dievart ODBC Diriver for SOL Azure
[JUseFTP Dievart ODBC Driver for SGLite
[ Fores 32 Eit Select... Meseart ONAC Mriver bor o sce

[ Show User DSMs

Test Connection...

0k Catcel Help

3. To retrieve the data from your data source, you can enter an SQL query and press F5. You

will be suggested to choose fields to be displayed.
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@ Edit Script [QV1] — O X
| File Edit Insert Tab Tools Help
“Reload #Debug < 4 - | -l i Tabs Main w =z
Main
ODBC COHWHMECT TO .E-urueyt-!unkey; "

SELECT * FROM ListMembers;

Dala  Funcions Variables Seftings

Database Data from Files
ODBC k Connect... [ Relative Paths Table Files...
— [ Use FTR
|__| Force 32 Bit Selec... - Gk \View File..
Web Files...
Field Data...
OK Cancel Help
Sheet Properties [Main] W%

General Fields  Objects  Securty Triggers

Awvailable Fields Fields Displayed in Listboxes

Clients_lconlUd ~ Email
Clients_MName ndd =
CreatedDate
P
First Mame
Id
|pOpt
IpSignup
lsGMarkey
Language
Last Mame
LastUpdate

Limdld

< Remove

4. Alternatively, you can click Select, and QlikView will show you the database structure

window where you can compose a SELECT statement for the data to be fetched. You can

© 2024 Enter your company name



Using in Third-Party Tools 91

choose a different database from the database drop-down list. Select the necessary tables
and fields. You can retrieve date from multiple tables and fields by selecting them and
clicking Add. When you are ready with your SELECT statement, click OK. You will get
back to the main script editor with your SQL statement. Press F5 to execute the script and

select the fields to be displayed in QlikView.

@ Create Select Statement - O x
Data source Devart ODBC Driver for SurveyMonkey Connect...
Database Driver.
Owier Support...

[ atabase Tables Fields | Text Order v|
Ostonal [Fades ~| I ~
T ables Images Clients_lconld
. nterestGroupings lenks Mame
Yiews : Graupi ol .
InterestGroups CreatedD ate
WSy ne Listhembers Emal "
System Tables | ListMergeFields N
[ &liases | iate ¥ | [ Show |con for ey Fields

Scripb  Table Column:  Preview  Blabs

5QL SELECT * (®) Colurnn
FROM ListMembers; () Row
() Structured
[J Preceding Load
Add

5. Once the data has been fetched, you can choose a table layout to present the data in a
table. Choose Layout > New Sheet Object > Table Box. Select the fields to be added to
the tablebox and click OK.
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Using in SSIS

SQL Server Integration Services (SSIS) is a component of SQL Server that is designed to
perform various data migration tasks. When using Devart ODBC Driver for Twilio as a
translation layer between the data source and SSIS, the driver and SSIS communicate via
Microsoft ODBC version 3.x.

Note that when you extract data from an ODBC data source using the sQLExecDirect function,
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an issue may occur: SSIS expects the ODBC 2.x behavior, while the ODBC driver continues
to fetch data from a data source via ODBC version 3.x. To prevent any issues when using
SQLExecDirect, you should force the ODBC 2.x behavior in the DSN settings: open the
Advanced Settings tab and select ver 2.x from the obBc Behavior dropdown.

General Advanced settings  License About

Meta Data
Connection
-
-
Compatibility
QDEC Behavior Ver 2, o
String Types Default &

IUse Local Regional Settings when converting to string

[ Imumbers [ ]Dates and times

Test Connection - Cancel
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413 Usingin Tableau

Importing Twilio Data Into Tableau Through an ODBC
Connection

This article explains to establish and ODBC connection to Twilio from Tableau Desktop.
Tableau is a data visualization tool that allows you to pull in raw data, perform analysis on i,
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and create meaningful reports to get actionable insights. With Tableau Desktop and our suite
of ODBC drivers, you can connect to various relational and non-relational databases, both
cloud and on-premise.

1. Run Tableau Desktop.

2. On the start page, select More... in the Connect pane.

3. Choose Other Databases (ODBC).

4. Expand the DSN drop-down list and select the DSN that you have created and configured
for Twilio. Alternatively, if you have not created a DSN, you can choose the Driver option
and select Devart ODBC Driver for Twilio from the drop-down.

. Click Connect.

. After a successful connection, click Sign in.

. Select the needed database and schema in Twilio.

. You should see the list of all tables you have access to in the connected data source.

© o N O O

. Drag-and-drop the table name to the area where it says Drag tables here to retrieve the
data, or click New Custom SQL to write a query that will select only specific data from the

table.

10.Hit Update Now to retrieve and display the data.

© 2015-2024
Devart. All Rights Request Support ODBC Forum Provide Feedback
Reserved.

© 2024 Enter your company name


https://www.devart.com/odbc/
https://www.devart.com/company/contactform.html?category=0&product=odbc/twilio
https://support.devart.com/portal/en/community/odbc-drivers
https://www.devart.com/odbc/twilio/feedback.html

	What's New
	General Information
	Overview
	Features
	Compatibility
	Requirements
	Licensing
	Getting Support

	Using ODBC Driver
	Installation
	Windows
	Silent

	Product Activation
	Obtaining Activation Key
	Activation on Windows
	Where to See the License Information?

	Connecting to Twilio
	Connecting to Twilio
	How to Get Live Credentials

	Connection String Parameters
	Enabling ODBC Tracing
	Supported ODBC API Functions

	Using in Third-Party Tools
	Using in DBeaver
	Using in Oracle DBLink
	Using in DBxtra
	Using in Microsoft Access
	Using in Microsoft Excel
	Using in SQL Server Management Studio
	Creating a Linked Server
	Troubleshooting in SSMS

	Using in OpenOffice and LibreOffice
	Using in PHP
	Using in Power BI
	Using in Python
	Using in QlikView
	Using in SSIS
	Using in Tableau


